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Introduction

Welcome to the MOT Form 700-50-67/68. The purpose of this document is provide guidance on how to
properly use the Excel form.

This form is not required and it will not work for Lump Sum or Design Build contracts. The error below will
be generated if a Lump Sum or Design Build contract number is entered. If a contractor wants to utilize
this form for their own quantity tracking, a blank form can be generated for another contract number and
the project information can be removed.

Microseft Visual Basic
o hig
Run-time error '9':

Subscript out of range

Irg

|-!
.

‘ End Help

Opening Form

NOTE: This form can be retrieved using two different paths:
e The first option is the Forms and Procedures website which provides a direct link to the
Final Estimates Forms website (see below).

MQT - Painted Pavement Markings - Daily
Worksheet

T00-050-67 12/2003 Construction Link Details

700-050-68 | MOT - Painted Pavement Markings - Coniractors 0272011 Construction Link Details
Monthly Certification of Quantities

e The second option is directly from the Final Estimates Forms website (see below). Click
on the form number to open the Excel file.

700-050-67/68 MOT - Painted Pavement Markings Daily Worksheet & Certification of Quantities (Instructions)*

Opening form (from the Construction Office website)

Before the form file will open, a window will appear prompting the user to: Open, Save, or Save As (see

window below).

What do you want to do with
700-050-67-68MOTForm.xlsm?

Size: 113 KB
From: www.fdot.gov

< Open

The file won't be saved automatically.

< Save

2 Saveas /

Cancel

3|Page


https://fms.fdot.gov/
http://www.fdot.gov/construction/FinalEstimates/FEdocs.shtm

MOT Form 700-50-67/68 — User Guide

If Open is selected, the form will open from the website as an Excel file.

If Save is selected, the form will save to a default location determined by the user's computer and
typically unknown to the user. It is not recommended that this be selected. If it is option chosen, please
note where the computer saves it.

If Save As is selected, the form will be saved to a location specially chosen by the user. This is the
preferred choice and will be beneficial when the file is exported (as discussed later in the instructions).

Once the Excel file is opened, a prompt to enable editing and/or enable content may appear. In order to
use this form editing and enable content must be enabled. If asked to trust a process, choose "Yes".

The security warning will look like this:

I SECURITY WARNING Macros have been disabled. Enable Content
The form will check for an internet connection. If no If connected to the internet, the form will prompt to
connection is found, a notice to that effect will provide a valid Contract ID, then the form will obtain
appear on the screen. contract and pay item data from the FDOT servers.

You are not currently connected to the internet. Will be
using existing contract information. Once you are able to
connect to the internet reopen this workbook, Enter Contract ID

—
-

Main Menu

The Main worksheet tab at the bottom of the form allows for adding new daily worksheets, updating the summary
pages and exporting the worksheets prior to submitting to FDOT.

Add New Daily Worksheet

Daily worksheets can be added as needed. However, it is recommended to only add one for each day.

Daily Worksheets

Daily worksheets are used to record each day’s quantities, location, and any special remarks concerning each
pay item.

IMPORTANT! DO NOT rename these worksheet tabs.
Doing so will break the code and the form will no longer work.

NOTE: Any changes to these daily worksheets will not show up on the summary page until they have been
updated from the main menu.
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Add MNew Daily Worksheet

1. Add a new daily by selecting the “Add New Daily Worksheet” button.

2. Alist of pay items by Project ID will appear.
a. First select the Project ID from the pull down

tab. ‘ 41840325201 j
b. Select all the items to be reported on this List of Payitems

Select Project Id

Dally Worksheet YOU may Use the "Select 010278 TEMPORARY RETROREFLECTIVE PAVEM EA f Create New Daily
All" button if you need all items. DIbmi2 3 PAVEVENTMARKING AEMOVABLETACE (F [ |
. . . 0710 11111 PAINTED PAVEMENT MARKINGS, STANI NM
Tip: You may select all items every time DI PANIED PAVEMENT wARNGS, ST - Sekect a1
and just record 0 for the unused quantities. §§§§§é Egﬁgggggﬁg% Eggggggﬁi Eﬁ”
c. Select “Create New Daily". DIZI PANIED PAVEMENT MARKINGS, aTAN Reset
0710 11251 PAINTED PAVEMENT MARKINGS, STANI LF
070511 1 DELINEATOR, FLEXIBLE TUBULAR EA
oy . . 0710 30 PAINTED PAVEMENT MARKINGS, FINAL LS
NOTE: DO NOT add additional pay items. The form is Close
designed to pull the contract pay items from

SiteManager. If the form is missing a pay item on your
contract, contact the System Section.

Add Quantities to Daily Worksheet

1. Select the appropriate daily worksheet tab at the bottom of the form.
a. NOTE: Each daily will be named as follows:
i. Project ID Number underscore Daily Sequence Number
Example: 2100035201 _Dailyl
IMPORTANT! DO NOT rename these worksheets.

Doing so will break the code and the form will no longer work.

2. Enter the Date: Cell P5.

3. Enter the Certification Number: Cell C5

4. Enter the name of the person certifying the quantities: Cell N7

5. Enter quantities in Column J starting on Row 12 for each reported item

6. Enter Location in Column L starting on Row 12 for each reported item
a. Location is Required

7. Enter Remarks in Column N starting on Row 12 for each reported item

a. Remarks are not required.

Remove Quantities from Daily Worksheet
There are two options for removing quantities from the daily worksheet.

Option One
1. Select the row of the item to be removed and delete that row.

Option Two
1. Set the quantity for the item to zero.
a. This item will be filtered out on the summary page.
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Remove or Delete Daily Worksheet Insert..
L_'x Delete
A daily worksheet may be deleted at any time. Doing so will not update the summary Rename
worksheet. The summary pages must be updated manually on the main tab if any of the daily Move or Capy...
worksheets are deleted or modified. &1 View Code
7 Protect Sheet...
Right click on the daily worksheet tab to be removed or deleted, then select Delete. Tab Color v
Hide
Unhide...
Update Summary Worksheets Select All Sheets

To update the summary worksheet, the quantities from the dailies for each project are collected and summed.
This process must be done each time you make a change to one of the dailies.

1. Onthe ‘Main’ tab, select the “Update Summary Worksheets” button.
Once the process is complete. A status message will be displayed:

Done Updating Summaries
Export Sheets and Close

Selecting the "Export Sheets and Close” button on the ‘Main’ tab will export all summary and daily worksheets to
another worksheet. This step is important in order to remove the program code and to make the file smaller for
submittal to FDOT.

NOTE: It is important to save the spreadsheet prior to exporting. The NewCopy ==
exported worksheet will be saved in the same location as the original
Excel spreadsheet (as discussed on Page 2); therefore it is crucial to saveCopyofWorkboakand Bt ook

note where the spreadsheet is saved prior to exporting. The opportunity
to change the location of the saved file will not be allowed during the
export process.

Signature blocks must be added to the form prior to exporting (see Digital Signature section below). However,
the signature blocks do not need to be digitally signed until after the worksheet has been exported. The form will
not export if it is digitally signed.

On the Main tab, select the “Export Sheets and Close” button

A window will appear asking for confirmation of the exporting action.

Select “Yes” to proceed or “No” to cancel. ("New Copy [E5)
Provide the name of the new workbook and select "OK". _
The currently opened workbook will close and the new A S
workbook will be saved in the same folder where the Exce]
original one is located.

ar®ONE

This Workbook shall be signed and submitted to the Department
or uploaded to the collaboration site (i.e., Project Solve) as an Excel file.

NOTE: Ensure the file extension is .xIsx and not .xls or .xIsm. The Save as type: drop down option should be
“Excel Workbook”, not “Excel 97-2003 Workbook.”

IMPORTANT! Follow all current procedures related to EDMS.

6|Page



MOT Form 700-50-67/68 — User Guide

Digital Signature

The use of digital signatures is supported by selecting the check box in the upper right corner of the Main Menu.
To insert digital signature blocks on the Summary page, select the Digital Signature check box and "Update
Summary Worksheets". (Unchecking this check box will remove the digital signatures blocks and insert the
standard signature block.)

NOTE: Digital signatures are required for use on projects let July 2016 and after. The digitally signed Excel file
shall be submitted to FDOT. Do not print a digitally signed file and submit as a PDF.

Main Menu

[ pigital Signature

Export Sheets and Close /
Reset
Digital Signing with Excel

To produce a valid digital signature, prior to applying your digital signature in Excel, ensure the calculation
options are set to Manual.

oYX R EREE BN

Insert  AutoSum Recently Financial Logical Text Date& Lookup

Add new Daily Worksheet

UpDate Summary Worksheets

@ -

Calculate Now

v

atch lculation B Calculate Sheet

Function @ Used -~ @ @ - Time- Referen(% ndow | Options ~
Function Library H} Automatic
= < . .
- E Automatic Except for Data Tables
Al Fe 1 —
:
A B C 0 E E w3 T . A

Then click Calculate Now on the Formulas tab.

File Home Insert Page Layout Data

fx EERBLE E T cane o
Insert  AutoSum Recently Financial Logical Text Date& Looku Calculation [ Calculate Sheet
Function < Used ~ < < =  Time~ Referenc {Dptions'
Function Library £ = Calculation

Excel 2013
1. Open the file to be digitally signed.
2. Onthe last sheet, right-click on the “Digital Signature” box and select "Sign"
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3. Enter your name in the text box and select “Sign”. Accept the Signature Confirmation prompt by
selecting "OK".

—
@ 3ce additional information about what you are signing...
X Before signing this document, verify that the content you are signing is correct.
o a
—_— X Cut -
Digitally Signed By Copy Type your name below, or dick Select Image to select a picture to use as your
Contractor's Authorize — — 7 signature: _ _ T ‘
P — Signature Confirmation 2
a a
. X John Doe I'/ 0 \I Your signature has been successfully saved with this document.
Gz Sign. Seledt Image... W' 1 the document is changed, your signature will become invalid.
Digitally Signed -
. Contractor's Authorized Agent [T1Don't show this message again
Signature Setup...
f— R To include information abeut the signer, click the details button, _ _
Order 3
\
& Format Picture...
Excel 2016
1. Open the file to be digitally signed.
2. On the last sheet, click View Signatures in the yellow ribbon.
-
0 SIGMNATURES This docurment contains valid signatures. View Signatures...

3. Select the down arrow next to the field to sign, then select Sign.

Signatures X
Requested signatures:

Prime Contractor's Work Site Traf... ‘I':\}
Contractor's | [&  Sign..

Signature Setup...

4. Enter your name in the text box and select “Sign”. Accept the Signature Confirmation prompt by
selecting "OK".

Saving a Signed File from Email

To obtain multiple signatures on the form, it is likely the form will be emailed from user to user. Right- click on the
attachment and select "Save As" or "Save All Attachments". See tips below.

8|Page



MOT Form 700-50-67/68 — User Guide

Message @TEE[J(IS)(

],

=

Preview
Open
Quick Print

NOTE: Do not double click to open and save the file. The

digital signatures will be removed.

Thank you! E& saveas

Ui Save All A <
&ShLﬁg Anderson g Save All Attachments...
Final Estimate Specialist
State Construction Final | B2 Copy
Flgrida Department of Tr

Remoye Attachment

ER

1, Savinga copy of this workbaok will remove all of the signatures in the copy. Do you want to continue?

] (e

Was this information helpful?

Additional Information

Additional guidance on digital signatures, how to obtain them from providers and how to properly use them can
be accessed on FDOT’s Construction website at:

http://www.fdot.gov/construction/eConstruction/DigitalSignatures.shtm

Reset

The "Reset” button on the ‘Main’ tab will reset the
workbook to the default contract state. It will delete all
worksheets and recreate the summary sheets for each contract.

1. Select the “Reset” button

a. A window will appear asking for confirmation of

the action.

b. Select “Yes” to proceed or “NO” to cancel. || s

c. Provide the Contract ID.

4 ™
NewCopy I-‘-I

Reset form? this will reset back to Default setting.

i. Once you provide the Contract ID, select “OK” to reset the form.

Tips

Saving File

Just close the spreadsheet. Do not try to File > Save As after a digital certificate is applied.

To save from an email, see instructions below.

Renaming File

If you need to rename the spreadsheet after a digital signature is applied:

a. Close the file and right click > Rename

Copy

PN N e

Create shortcut
Delete

Rename

Properties
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b. Or, double-click on the file name so it become editable.

Emailing File
To email the spreadsheet, drag the file from your folder into the email.

[WSSWSM st Options  FormatTet  Review Help @ Tellme Lcoely Share  View - @
""D Calibri [ » |:'; » U ® | [ Moveto~ ¥ Delete - T~ B
B I U i N .
fomm u Names Include Tags T Pm;:;g:mk Copy Paste & Copyto TiRename le::r Properties =3 select
- ¥ (¥-A- - - * | Templates
Clipboard Organize New Open
Clipboard Basic Text [} Wy Templates -
« - < AA > Test v O | Search Test Vad
| © anderson, ashley | N ~
Name Date medified
‘ ‘ # Quick access
T4424(T00050564) xlsx 5/4/2018 337 PM
‘ ‘ ¥ Downloads
7@ OneDrive for Business
Subject [700-050-56A J »
%] Documents »
=] Pictures »
AL #»
Thank you! Ashley »
Ashley Andevson, PE Plans for Districts »*
Final Estimate Specialist FinalEst v >
tate C Final Estimate Office litem  State:@Online  Sync status: €) Error

To save the spreadsheet from an email, drag the file from the email to your folder.

w  J00-050-56..  Attachment To.. = — i | = | Test - m]
P H sh Vi
Message Help Attachments ' Tellme ome are o
= o o ] b
B B2 E ) R » =] .
- Pinto Quick Copy Paste _ I New  Properties
Actions  Save  Save All Saveto SaveAllto Selection  Show aceess [z - - &
h As  Attachments  OneDrive > Onelrive - Message Clipboard Organize Open
Save to Computer Save to Cloud Message ~
« L « AA > Test w & Search Test
Fri 5/4/2018 3:44 PM
~

Anderson, Ashley -

© 700-050-56A
To @ Anderson, Ashley

Name
# Quick access

¥ Downloads This folder is empty.

[ Deskiop
=) T4424(70005056A).xlsx n
’% 78KE e Documents *
=1 Pictures + ¥ <

. D items State:@Online Sync status: €3 Error

r
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Invalid Digital Signature
A recent update to Excel forces the menu bar settings to be global (all files) instead of for each individual file, so
the manual calculations settings does not lock as it once did.

To test if this is the problem:
1. Open a blank Excel workbook.

8 I—
2

[ T W R Sy N

7
Blank workbook

2. Then, select Formulas > Calculation Options > Manual
Page Layout Data Review View Developer Help ELUEBEAM

E Im — Define Name ~ #i7 Trace Precedents (%] Show Formulas m
L] =it P

“:E Trace Dependents Y1 Errar Checking -

Date & Lookup & Math&  Mare Name X — Watch | Calculation
- Time~ Reference~ Trig~ Functions~ Manager 5 Create from Selection R Remove Arrows ~ (%) Evaluate Formula Window | Options =

}3 Tell me what you want to do

Calculate Now

Eﬁ Calculate Sheet

rary Defined Mames Formula Auditing Automatic

Automatic Except for Data Tables

I +  Manual I

3. Leave this file open in the background and open the digitally signed file in question. The settings from
the blank workbook should carry over to the digitally signed file and the digital signature should show
valid if the Excel Update is the issue. If you have additional questions, contact the SCO System Section
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